1. Go to Student Common/Computer Technology/Spreadsheets/Assignment 1. This will open up a Word Document. Go to the website indicated on the sheet: http://www.usd.edu/trio/tut/excel/index.html. This is a basic tutorial on Excel and on Excel vocabulary, which will be what is on the final at the end of the semester.

2. Print a copy of Assignment 1, then answer the questions on it as you go through the tutorial.

3. At the end of the tutorial there will be a quiz. Take the quiz, and print the results.

4. Staple your quiz to the tutorial and turn into the basket when finished.

---

1. Open Student Common/Computer Technology/Spreadsheets/Assignment 2. Here you have the nutritional information for some of the items on the menus of various fast-food restaurants.

2. First we are going to move the contents in Cell A2 into A1. Click on cell A2. Place your cursor on the EDGE of the cell so that it turns into a four-sided arrow. Then drag it up one cell, into cell A1.

3. Now lets make column A wider so we can see the contents easier. Place your cursor between the A and B so that it turns into a two-sided arrow. Double click.
   a. The column should automatically re-size to the length of the longest word in that column.

4. Highlight Row 1. Right click on the area you have highlighted and choose Insert from the menu.
   a. In the new A1, type the title “Nutritional Facts”
   b. Highlight cells A1-F1 and press
   c. Change the font size to 18.
   d. Change the color to a color of your choice by clicking on the button.
   e. Change the font to a readable font of your choice.

5. Now highlight cells A2-F2.
   a. Change the color of the fill to yellow by clicking on the button.
   b. Change the font to 14. Bold it by clicking on the button.

   b. Change the color of the fill to red, the size to 14, and bold it.

7. Now we need to copy and paste the information from sheet 2, for Burger King.
   a. Click on Sheet 2 at the bottom of your screen.
   b. Highlight cells A1-F16. Copy it by pressing CTRL+C, pressing from the home ribbon, or right click and choose Copy from the menu.
c. Go back to Sheet 1. Place your cursor in cell A36.

   a. Highlight cells A36-F36. You have now copied the format to the new cells.
   b. Change the fill color to blue.

9. SORT. Highlight cells A3-F17.
   a. Go to the Data Ribbon.
   b. Click on the sort button.
   c. Pull down the sort by menu, and choose Calories from the list.
   d. Now highlight cells A20-F34. Sort this one by size.
   e. Highlight cells A37 – F51. Sort this one alphabetically.

    a. Double click between the A and B again to resize column A, now that the font is smaller.

11. Highlight cells A3-F17. Click on the borders tab and choose All Borders.
    a. Do the same for cells A20-F34, and A38-F31.

12. Highlight cells B3-F3.
    a. Right click and choose Format Cells. Click on the Alignment tab. Change the orientation to 45 degrees.
    b. Do the same for cells B20-F20.
    c. And again for cells B37-F37.

13. Now we are going to insert some pictures. Go to the internet, and to Google Images. In the Image search, type “McDonald’s Logo.”
    a. Find a logo that is rather small. Click on it, then go to See Full Size Image. Right click and save this logo into your My Pictures folder.
    b. Find a logo for Wendy’s and for Burger King.
    c. Go back to your assignment and click on Insert, then Picture. Find the McDonald’s logo, and insert. Place it roughly in column G. Do the same for the other three logos.

14. Add a header. Go to the Insert ribbon, and choose Header. Type your name in the left column, and Assignment 1 in the middle column.
    a. Go to View, and choose Normal to get back to your original view.

15. Check to make sure that your document is only 1 page long.
    a. Click on the Office button, go to print, and then print preview. Check the bottom of the page to see that it says page 1 of 1.
    b. If it isn’t, go to Page Layout, Margins, and change the margins to Narrow. If it IS only one page, you are ready to print.

16. Make sure you SAVE this document in MY DOCUMENTS. Then print it and turn it into the basket.
1. Open Microsoft Excel. Choose Assignment 3 from the Spreadsheet file in Computer Technology.
2. Now you will sort the gymnasts, first by county, then by name.
   a. Highlight cells A2-G23. Go to the Data ribbon, and choose sort.
   b. In the pull down menu next to Sort By, choose Country.
   c. Click Add level. In the next pull down menu, choose name.
   d. Press ok.
   a. Go to the Home Ribbon and choose Wrap Text from the menu.
   a. Click on the Alignment Tab.
   b. Click to put a check mark next to Shrink to fit.
      i. Now the names should all fit, without you having to widen the column.
5. Highlight cells C3-H3. Click on the button in the Home Ribbon. You now have a total for Jade Barbosa.
   a. Now try it again with Fei Cheng’s scores.
   b. Once you have done it a few times, review using autofill. Highlight cell H4 and put your cursor on the lower right hand corner until it turns into a black plus sign. Drag down to row 25.
6. Now highlight cells C3-C24. Use the button again to total the scores for uneven bars. Do the same for all the other events.
7. Time to find the Average. You have to be careful because you do not want to calculate the Total into the average!
   a. Put your cursor in cell C25. Type =Average( (include the open parenthesis!)
   b. Then highlight cells C3-C23. NOT the total. You should get 16.179 as your answer.
      If you got a much higher number, that is because you calculated the total with it.
   c. Now do the same for each of the events.
   a. Do the same for A2-H2.
   c. Change the font to 16 and choose a readable font of your choice.
   d. Highlight cells A1-H25. Change the borders to All borders. Then choose Thick Box border from the list.
9. Add a header and print. Turn into the basket.

2. This is a list of Student Loans from Summer Ridge Community College. Make the following changes to the look of the sheet:
   a. Highlight A1-I1 and center across using the Merge & Center button. Do the same to A2-I2. Change the font size to 18 pts. Change the font to Times New Roman.
   b. Highlight A3-I3. Click on the Wrap Text button. With the cells still highlighted, center them. Then Underline. Change the shading to gray.

3. Double click between the A and B to widen column A, so you can see all names.

4. Now you will be changing the format of several of the columns.
   a. Highlight column B. Right click and choose Format Cells. On the Number tab, choose Special, and Social Security Number.
   b. Highlight column C. At this school, account numbers are formatted as ####-##. You will have to do a custom format.
      i. Go to Format Cells, and choose Custom. In the Type box, type ####-## and press ok.
   c. Highlight column D. Press the $ button to change the format to money.
   d. Highlight column E. Go to Format Cells, and choose Date from the Category list. Choose 03/14/01 format.
      i. Double click between the E and the F to resize column E.
      ii. Resize any other column that needs it.

5. Now we will calculate the monthly payments required by each account, in the F column.
   a. Place your cursor in cell F4. The minimum due is determined by one payment every 12 months for ten years. This is really TWO math problems, but it can be done in one formula as follows:
      i. Type the first problem—the amount due divided by 10 years (which tells you how much they must pay EACH YEAR) into parenthesis. Then divide that by 12—the 12 months of one year. It should look like this: =(D4/10)/12. If you did it right, you should have a minimum payment due for Bethanne Arne of $165.54.
   b. Now you will calculate the interest for each payment and add it to your total. Again, this is TWO problems you will put in one formula. First, the amount due * the interest, and then that total added to the amount due. It should look like this: =(F4*G4)+F4. If you did it right, your answer should be $172.99.
   c. Now that you’ve done the math, you can use Auto Fill to pull down the answers to all the problems.

6. Sort—Currently the names are sorted by name. We want to sort them by account number.
   a. Highlight cells A3-I31. Go to Data, Sort. Sort by Account number and press ok. Tabithah Garland should now be the first name on the list.

7. Filter—Now you will use a filter to answer the questions on the Questions Worksheet.
8. Highlight cells A3-I31 and click on Filter. Now there are pull down arrows on each row.
   a. Click on the Questions worksheet and answer the questions using your filter.
   b. When you are trying to find an answer, make sure you are filtering the right column.
      When you are finished, make sure you pull down the arrow again and choose ALL to show all listings again.
   c. To get these answers, you will be using Sort A-Z and Number Filters as well. Make sure you test them out!
9. When finished, add a header to both pages and print both. Staple them and turn in to the

You are a teacher’s aide at Elk Ridge Middle School. Your teacher has asked you to record grades for one of her classes. You are to list the assignments and test, compute the total points for each and calculate the percentage and assign the grade.

1. Key in the worksheet below. Be sure to add a Header with your name, period, and assignment number.
2. Add a first name for each of the last names given. After keying in the column headings and column A, add gridlines with the border key.
3. Widen columns to accommodate all entries (do not cut off any information). Use auto sum to find the totals in column F.
4. To find percent in cell G5, divide the total by the points possible—180.
   a. Format column G to a percent by highlighting the cells and press the % button from the tool bar.
5. Sort the students and all information about each A-Z.
6. In cell B17, find the average by using the =AVERAGE( function. Enter the cells to be averaged between the parenthesis. Auto fill the formula across.
   a. Ex: AVERAGE=(B6-B15)
7. In cell B18, find the maximum score by using =MAX(. Enter the cells to be maxed between the parenthesis. Don’t include the point totals in your cell range!
8. In cell B19, find the minimum score by using =MIN(. Enter the cells to be min between the parenthesis.
9. Format the document to look like the one below. Print preview, print, and turn into the basket.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Points</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Hughes</td>
<td>15</td>
<td>25</td>
<td>35</td>
<td>95</td>
<td>180</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Williams</td>
<td>14</td>
<td>24</td>
<td>40</td>
<td>94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Collins</td>
<td>10</td>
<td>24</td>
<td>39</td>
<td>92</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Gomez</td>
<td>14</td>
<td>20</td>
<td>32</td>
<td>87</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Samuels</td>
<td>9</td>
<td>12</td>
<td>31</td>
<td>81</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Johnson</td>
<td>10</td>
<td>15</td>
<td>30</td>
<td>95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Burrows</td>
<td>4</td>
<td>20</td>
<td>16</td>
<td>81</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Anderson</td>
<td>7</td>
<td>21</td>
<td>26</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Taylor</td>
<td>11</td>
<td>15</td>
<td>35</td>
<td>64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>McKee</td>
<td>15</td>
<td>23</td>
<td>37</td>
<td>89</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Average</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Highest</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Lowest</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Open Microsoft Excel. Open Student Common and choose assignment 7.

1. Type in the information from the in-class survey. If you were absent that day, use the information given below.

2. Before making the charts, right click on the Assignment 6 tab. Choose Insert>Worksheet.

3. Title the new worksheet “Graphs”

4. You will make four graphs for each survey, as indicated below:

   a. **Birthdays – Pie**
      i. Highlight cells A4-B15. Go to the Insert tab from the list. Choose a style.
      ii. In the Chart Layouts, choose a layout that shows the percentages.
      iii. Change your chart title to Birthdays.
      iv. **Highlight your graph and choose move chart from the toolbar.** Select “Graphs” from the pull down menu. Arrange the chart on the new sheet you created.

   b. **Grades – Line** (if you don’t remember, guess!)
      i. Highlight cells D3-F15. Create a line chart.
      ii. Choose a chart layout, and title your chart Cumulative GPA and then your name.
      iii. Right click on the left axis and choose Format Axis.
      iv. Change the maximum to fixed, and then type in 4.0 instead of 4.5.
      v. You may change the minimum axis if you wish.
      vi. Move the chart to your Graphs tab.

   c. **Favorite Junk Foods – Column**
      i. Highlight A22-B26.
      ii. Go to Insert, Column, and choose a style from the first column.
      iii. Choose a Chart Layout that includes a title, and call it “Junk Food.”
      iv. Click on the Switch Row/Column button—this will give you a better legend.
      v. Now click on the first bar, pizza, so only it is highlighted. Right click. Choose Format Data Point. Click Fill. Then click on Picture or Texture fill.
      vi. Click on File, and go to Student Common/Rees Computer Tech/Spreadsheets. You will see a picture of pizza. Click on that. Then choose Stack and Scale. Do this for all the other columns.

   d. **General Survey – Bar**
      i. Highlight D19-G28.
      ii. Follow the same steps, adding a title and moving to the graphs column.

5. Print only the graphs page. Make sure all of them fit on one page using print preview. Add a header and print.

If you were absent the day we did this in class, please use this information.
1. Today you will be creating a graph in Excel which will show the popularity of your name and other names that are meaningful to you. NOTE: If you have a very unusual name that is not on the list at all or very little, you may select any other names of your choice for this assignment. Please open up a blank page in Excel.

2. Now, go to the Social Security website. This site tracks the top 1,000 names each year going way, way back. The site is: http://www.ssa.gov/OACT/babynames/.

3. You will see a section telling last year’s top ten names. Below that, is the specific name selector. Enter your name, or the name you would like to graph, in the space provided. Indicate the gender. On number of years, enter about 110, or far enough back so that the year 1900 will appear.

4. You now will see a list of each year and what the name you entered ranked each year. If the rank shows a, that means that it was not in the top 1,000 for that particular year.

5. Now we will graph it. Because this graph is going to show change over time, we are going to create a line graph. First we need to enter the information. In a column, enter the years 1900, 1920, 1940, 1960, 1970, 1980, 1985, 1990, 1995, 2000, 2005, and the most recent year. Then, enter the rank for each year. If that particular year does not have a rank, leave it blank. Your information should look something like this:

6. Graph it. Highlight the information, and choose a line chart from the Insert menu.

   a. Most likely, you got a chart that looks like the one below.
   b. SOMETIMES, this doesn’t happen. In the chart below, Excel recognized that the years 1900-20-- are YEARS and not just numbers. If your chart does not look like the example, you will need to reformat the years so that Excel does not treat them as numbers.
      i. To do this, highlight your years entered. Right click and choose Format Cells. In the number list, choose Text.
   c. If your chart DOES look like the one below, do not follow the above step.

7. Now, this chart is ok, but there are many things we can do to make it more meaningful.

8. When making a chart, you want to make sure that the data you are trying to present is clear and meaningful. This chart as it is, is misleading. At first glance, it looks like the name “Molly” was extremely popular in the 1900’s, and then died down by 2008. This is not quite true. It became MORE
popular as time went by. We need to reverse our dates, so that the high points of the line indicates high popularity. There are two ways to do this:

a. You can either retype in or rearrange your dates in the data you entered so that the most recent date is on top.

b. Or you can right click on the axis (the numbers lining the left side) and choose Format Axis. Then just check the box that says “Values in reverse order.”

c. Choose one of these options, or try both. In my example, I will do the second option.

9. Now your graph more accurately shows the popularity of the name. But there is still a problem. The graph makes it look as if Molly was not at all popular in 1900, and increased rapidly after 1970. This is not quite true either—because our Axis is off. Remember that we are looking in the top 1,000 names—and Molly starts at 411. Therefore, it was moderately popular in 1900, not at the bottom of the list.

a. To fix this problem, right click on the left axis, and choose Format Axis. You will see a dialogue box appear like the one above.

b. Next to Maximum, click on the “fixed” circle. Then change the amount to 1,000. Then click Close.

c. Now the graph is a better representation of the name.

10. Highlight your chart and go to Chart Tools. Change the layout to Layout 1, as shown.

11. Now, I have assumed in this example that you have chosen a name that has data for each of the years given. It is very possible that the name you choose will not have existed in 1900, or it will have periods where it does not show up on the list at all. I will address these problems as well as we add three more names to our chart.

12. Choose three more names and list them and their data next to your first name. You may want to select family members or friends, names that mean something to you. They will not yet have any impact on your first graph. Go back to the Social Security website and enter the name on the left side and select Go. Then enter the information. Again, if the name
has no data for particular year, leave it blank.

13. I have chosen to enter the names Ashley and Chloe. Notice that Ashley did not appear until the 60’s, whereas Chloe was unpopular for several decades and then reappeared.

14. To add these names to your graph, do the following steps:
   a. Highlight your graph. Note that your data has colored lines around it.
   b. Put your cursor on upper right hand corner of the green section, so that your cursor turns into a two-sided arrow. Then pull the lines over to encompass your new columns.
   c. Now the new information was added to your graph.

15. Now we still have problems. Notice that for Chloe, the line just disappears then reappears. For Ashley, it appears suddenly. Keeping the cells blank for the years the name does not appear makes this graph more confusing.
   a. What if we just enter zero? Try it.
   b. This fills in the gaps, but it also makes it look as if the name was really popular those years, instead of not appearing at all.
   c. Ideally, we would enter the rank for those names, even if they are below 1,000, but we do not have that data. So now, try entering 1,000 into those blanks.

16. This makes the graph look more accurate. Although these names were NOT ranked at 1,000 those years, the graph still indicates the sudden rise in popularity for these names.

17. Make sure you go back to the chart format, as you did in step 12, and change the formatting back. Your title should be **Name Popularity** and then below that, **Top 1,000 Names**. Change the size of the subtitle to 12. Change the left axis to read **Rank**.

18. If you feel it is necessary, depending on the data you have, you could also change the years to be more accommodating. If you want to change the years so that your year of birth is represented, do so. Or if all three names you chose do not appear until later, there is no reason to start in 1900. These are changes you make to make this graph more meaningful. That is the purpose of a graph!

19. You can also right click on various parts of the graph and re-format the color, fill etc. You can add more names if you want as well. When finished, your graph should look something like this:

20. Add a header, print preview, and print.
Create graphs with the sets of information given. All information comes from actual sources. You must organize it yourself in Excel and choose the graph that best describes that information. You will be graded on how easily you can read your chart. Questions are provided to help you know if your chart is readable—if you cannot read the information, rearrange your chart!

Label each sheet Graph 1, Graph 2, and Graph 3. Complete each graph with it’s data on a different sheet. You will need to print all three sheets, staple them, and turn them in to the basket. Remember—you will not get credit if there is no DATA with your graph. I need to see how you laid it out.

Tips:
- Sometimes you may want to change the SCALE of your chart.
- Adding VALUES or PERCENTAGES to your chart can make it more readable
- Labeling the X and Y axis is sometimes necessary.

1. **Kobe Bryant PPG**
   a. Create a chart that shows Kobe Bryant’s PPG over the course of 15 years, beginning with 96-97, 97-98, and so on until 10-11. (You may go online to find out his PPG for any years after 10-11)
   b. *Compare* this to his overall average over the course of those 15 years.
      i. *Hint:* You will need to calculate his average before you make this chart.
   c. Here are his PPG from 96-97 to 10-11: 7.6, 15.4, 19.9, 22.5, 28.5, 25.2, 30, 24, 27.6, 35.4, 31.6, 28.3, 26.8, 27, 25.3
   d. NOTE: When entering your years—when you get to 01-02, Excel will automatically change it to a date. (Jan '01) Just right click on the cell, go to Format Cells, and choose “text” from the category list.
   e. *Answer these questions below your graph:*
      i. How many years did Kobe Bryant get above his average?
      ii. What year did he score the least amount of points?
      iii. What do you think the graph is trying to say?

2. **Nutritional Facts**
   a. Using the information in Assignment 1, create a graph. You may use the information in any way you wish. Decide what point you are trying to make, and then create a graph that shows what you want to say. (Hint: You can choose one single item, you can find AVERAGES, you can COMPARE similar items, etc.)
   b. *Answer these questions below your graph:*
      i. What is this graph trying to show?
      ii. What is significant about the information in your graph?

3. **Civil War Data**
   a. Go to [http://www.civilwarhome.com/casualties.htm](http://www.civilwarhome.com/casualties.htm), or pull up the file in Student Common/Spreadsheets/Assignment 8 – Civil War.
b. Using the information in this article, create a graph. There are TONS of different angles you can take with this—make sure that your graph makes sense and is saying something!
   i. **Extra Credit:** Create a 4th graph with actual information you find on the internet. Please include the resource (URL) where you found the statistics.

---

Open Assignment 9 from Student Common/Computer Technology/Spreadsheets.

1. Highlight cells A1-J1. Click on the button on the home ribbon to wrap the text. Underline it and Bold it. Shade it with gray.
2. Highlight row 1 and row 2. Right click, and choose Insert from the menu.
   a. You should now have two new rows!
   b. In Row 1, type *Hair Dot Net*
   c. In Row 2, type today’s date.
      i. Right click on the date and go to format cells.
      ii. In the Number tab, click on date, and choose March 14, 2001 as the format.
   d. Use the button to merge and center both rows, one at a time.
   e. Change the font to one of your choice for both rows.
   f. Change the font size in row 1 to 18. In row 2, change the size to 12.
   a. Go to the alignment tab, and choose Shrink to Fit.
4. Now go to D4. We want to find out what a 20% discount on the Original price is.
   a. Type =C4*.25 and press enter.
   b. You now know what 20% of 13.50 is. Now calculate Our Cost, by subtracting the discount from the original price: =C4-D4.
5. Now we are going to markup our price by 50%—that’s how much we charge the customer.
   a. In F4, you will find out what 50% of our cost is.
   b. Finding the percent of a number is on the final, so make sure you know how to do this!!!
   c. In G4, add our cost and the markup together, to get the customer cost.
6. Now you know your customer cost. We need to charge them a tax of 6%. So this time, you will multiply the customer cost by 1.06.
7. In column I is listed how many of each item were sold. We need to figure out our profit.
   a. In J4, multiply the amount sold by MARKUP, NOT by customer cost.
8. Now let’s sort this list by Profit. Highlight cells A4-J24.
   a. Go to Data, and sort it by Profit.
9. In A25, type Totals. Then sum the totals for all the columns.
   a. Highlight the cells A25-J25 and change the shading to gray.

---

**B - 11**

11. Go to the Page Layout Ribbon. Choose Orientation and then Landscape.

12. Highlight rows 4-25 and change the font size to 10.

13. Print preview and ensure that the whole document fits on one page. If it doesn’t, resize some columns to make it fit.

14. Add a header, Print, and turn into the basket.

Open Assignment 10 from Student Common/Computer Technology/Spreadsheets.

You have just gotten your first job after graduating from college. You will choose a number between 1-30.

1. Open Excel and open Assignment 10.

2. Choose a number 1-30. Type the number you chose in B31.

3. Go to Sheet 2 and see what your individual situation is—if you are married, how many dependants you have, your job, and if your spouse works.

4. Fill in the Income section.

   a. Type your total income in B3.

   b. Enter your number of dependants in B5. This may or may not include your spouse.

   c. Enter your student loan amount in B8.

   d. Enter your credit card debt in B9.

   e. Note your NET INCOME in B7—this is how much money you have each month after paying taxes and insurance.

   f. Enter the amount you owe in student loans and credit card debt.

5. Fill in information for monthly expenses.

Go to Student Common/Rees Computer Tech/Spreadsheets/Assignment 10 List. Use this list to fill out the fixes expenses section. Choose a house, car, food, clothing, and entertainment options. IF YOU HAVE A SPOUSE, YOU MUST PURCHASE TWO CARS (OR MODES OF TRANSPORTATION)

**Groceries** – Choose from the list your level of groceries, making sure to add the right amount for each dependant in your family.

**Utilities** – Pay 25% of your house payment. Ex: =1200*.25

**Car Insurance** – Pay 20% of your car payment. Ex: =300*.20

**Gas** – Pay $100 per month per vehicle.

**Phone Service/Cable/Internet:** Choose the type of phones, cable, and internet you want. You do not HAVE to have cable or internet—but can you really live without it?
Clothing -- Choose from the list your type of clothing, making sure to add the right amount for each dependant in your family.

Daycare – If your spouse is working, you must pay $500 per kid per month. If you have more than three kids, you can only pay $100 for the oldest, as they will be in school and only need after school care.

Charity – If you would like to give to charity each month, this is already calculated at 10%. If you do not want to give to charity, just delete the amount.

6. You start with $200 in your account. Enter your income, then your total fixed expenses. Subtract your expenses from your income in E5, Remaining.

7. Now you will calculate your unfixed expenses.

Student Loans & Credit Card Debt – The minimum you must pay on your loans is listed in yellow. You will fill it in on the unfixed expenses section. You can pay more than the minimum—in fact, it is encouraged you do so. Otherwise you will NEVER get out of debt!

Savings – This is optional—you choose how much to put in each month.

Misc Spending – Enter AT LEAST $200 here—you do not want to leave your account at 0 each month—this is your cushion.

Entertainment – Enter whatever you would like from the entertainment options and the extras.

Unexpected Expenses – You MUST do all the unexpected expenses on the list that apply to you. Use the “extra” boxes to take out money you need to.

8. Now do a four month budget of your expenses. You must have at least $50.00 left over at the end of each month. If you do not have $50 left over each month, change your expenses until you can afford it.

9. Each month should be different! Make sure that you add your carryover over from each month.

10. When finished, add a header, print, and turn in to the basket.
Open Assignment 11 from Student Common/Computer Technology/Spreadsheets.

1. On the tab marked BMR Formula, you will be calculate your Body Mass Index—this will tell you how many calories a day you should be eating in order to maintain your weight.
   a. In cell B15, type your height IN INCHES. So, five feet is 60 inches, so if you are, say 5 foot 6, then you are 66 inches tall.
   b. In cell B17, type your weight in pounds
   c. In cell C18, type your age.
   d. In cell C19, type your activity factor. This is a **NUMBER**, using the Activity Factor guide just below this.
   e. Again, make sure you type a number into this box, not words.

2. Now look at the colored boxes at the bottom. If you are male, your BMR is in the blue box. If you are female, it is in the red box.
   a. Go to the Food Chart tab, and type that number in cell B2.

3. There are many websites that allow you to calculate your calories—unfortunately they require a login and most of them either charge or expect you to be 18. Therefore, I will provide information for ten days for you. I have entered it using the website Fitday.com.
   a. We will enter Day 1 together as a class.
   b. You can find days 2-10 on the Daily Intake sheet. DO NOT PRINT THIS SHEET.
   c. Use the information on this sheet to fill out your food log. You need to enter the number of calories eaten, and the percentages of Fat, Carbs, and Protein. (from the pie chart)

4. You should now have your calories for each day entered. You are ready to figure out how much OVER or UNDER the daily intakes are from your BMR.

5. In cell B2 enter your BMR.
   a. In cell C5 do the following formula: =B5-B2.
      i. Now, if you were to use autofill, you would not get the right answers. We need to turn B2 into an ABSOLUTE VALUE, so that when we use autofill, it does not change.
      ii. Go back to cell C5 and change the formula to =B5-$B$2. Now when you use autofill, your math will be correct.
iii. This is subtracting your BMR from the number of calories you ate that day.

b. In cell D5, do the following formula: =C5/$B$2. This is figuring a percentage deficit or surplus. Change the format on this column to %. 

c. Now you can see if you are eating too much or too little. If you would like to lose weight, you want your deficit to be somewhere between 20-30%, no more and no less. If you want to gain weight, you need to exceed your calories by at least 10%.

6. Now look at your fat % column. All of the days where your percentage is higher than 30%, change the color to red.
   a. Regardless of how many calories you eat, if your fat percentage is consistently higher than 30% you are not eating healthy!

7. Now let’s graph some of our results! We will be making two charts—one to determine how we have done staying within our goal of calories, and the other to determine our total intake of fat, protein, and carbohydrates compared to what our intake SHOULD be.

8. In the Food Chart tab, highlight the percentages for your fats, carbs, and proteins. This SHOULD be cells E5-G14 if you have ten days.
   a. Copy this, and click on the Graph Setup page. Paste it into cell A1.
   b. In cell D1, type “Fat Goal”, in E1, type “Carb Goal” and in F1 type “Protein Goal”.
   c. Then, in put in the percentage you SHOULD be eating of each nutrient, as shown.

9. Highlight A1-F11, and create a Column Chart. Click on the far right option for Chart Layout. Change your chart title to Nutrient Intake.

10. Now, you will change the chart type for some of the items. Looking at your legend, click on the row of columns that corresponds with your Fat Goal. Click on it. Then in the left corner choose Change Chart Type. Change it to a line chart, without the dots.
   a. Do the same thing for Carb Goal and Protein Goal.
   b. Last, you are going to change the colors of your remaining bars to match their corresponding goal.
      i. In your legend, click on Fats, then right click. Change the color by right clicking and choosing a color from the bucket button. Pick the SAME COLOR that is being used for your fats goal.
         ii. Do the same for your Carbs and Protein.
      c. Last, move the chart into the graphs tab by highlighting it and choosing Move Chart Location on the right side of the Chart Tools bar.

11. Now you are ready for the second chart. Go back to your Food Chart Tab.
Highlight the dates and the calories, cells A4-B14. Include the titles. Copy them into the Graphs Setup tab.

a. In the next column over, type in your BMR for every day. Your amount of calories changes every day, but your BMR stays the same!

b. Now create a line chart, and call it Calories Eaten. It should look like the example below.

c. Move it to the Graphs tab.

Add a Header to each page.

Print Preview to make sure both of your graphs take up only one page.

Print your Cover Sheet, Food Log, Graphs Setup, and Graphs page. Staple and turn in to the basket.

For this assignment, you will be using a worksheet handed to you. If you need another copy, you can get it from Student Common/Computer Technology/Spreadsheets/Assignment 12. You will learn all about how to use a Loan Amortization chart to figure your monthly payments and interest for the purchase of large items.

Open a new workbook. Create the worksheet below.

a. Make sure you widen each column to fit the text.

b. Align the text in the columns to match the worksheet below.

c. Center the title over the cells.

d. Change the font on the title to a font of your choice. Change the size to 16.

e. Compute the total for each person

f. Compute the Team Average for each game. Do not average the Total column.

g. Shade the Team Average row to light gray

h. Format the Team Average for each game as Number with 1 decimal place.

i. Insert a new column to the left of column B
In cell B3 key: LAST NAME. Format this heading like the other headings.

k. In cell A3 change the heading to: FIRST NAME

l. Change the height of row 3 to 48.

m. Change the Font of row 3 to 10 point bold

2. Wrap the text in each cell of Row 3.

3. Change the orientation of the text in row 3 to a 45 degree slant from left to right (use the alignment tab in Format Cells to do this.)

4. Highlight A3 to F8 and choose All Borders
   a. Change the alignment in row 3 to center
   b. Beginning in cell B4 to B7, key the following: Simpson, Burns, Mann, Szyslak.

5. Create a Bar Chart for the information in cell B3 to E7.
   a. Title the chart Bowling Team Comparisons.
   b. Place your name as a subtitle below the title.

6. Now create a Pie Chart.
   a. Highlight the names of the players and the information for totals only.
   b. Create a 3-D pie chart.
   c. Choose a chart layout that will show the percentages.
   d. Title the chart Player Game Totals
   e. Make sure both graphs fit on one page.

7. Add a header, print preview to ensure it fits on one page, and print.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PIN PALS BOWLING TEAM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>NAME</td>
<td>GAME 1</td>
<td>GAME 2</td>
<td>GAME 3</td>
</tr>
<tr>
<td>4</td>
<td>Homer</td>
<td>125</td>
<td>165</td>
<td>172</td>
</tr>
<tr>
<td>5</td>
<td>Montgomery</td>
<td>101</td>
<td>98</td>
<td>115</td>
</tr>
<tr>
<td>6</td>
<td>Otto</td>
<td>202</td>
<td>192</td>
<td>168</td>
</tr>
<tr>
<td>7</td>
<td>Moe</td>
<td>138</td>
<td>151</td>
<td>161</td>
</tr>
<tr>
<td>8</td>
<td>Team Average</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There are times when the data you might have to analyze is not numerical in nature. So how can you use Excel to analyze data that is predominately text? This assignment is designed to show how you can analyze this kind of data. In addition, you will learn to use the ROUND function, and apply some different formatting to your worksheet, as well as make a copy of a worksheet. As always, read through the entire assignment before you begin working and be sure to save often.

1. Go to Student Common\Simpson CompTech\Spreadsheets and open Spreadsheet Assignment - Office Specialists and then save it as: Last, First - Spreadsheet Assignment - Office Specialists

2. Click the Worksheet Selection button (see image at right or Ctrl A to Select All) and change the font to Times New Roman, Bold. **Do NOT worry about column A’s width right now. You will fix that later.**

**Formulas Creation (You need to read the paragraph below!)**

**COUNTIF and COUNT Functions** – The key to converting text data to numerical data is through the use of the COUNTIF and COUNT functions. The COUNTIF function counts cells that contain data according to specific criteria. The COUNT function counts cells in a range that contain
numbers. As you see in the workbook you have open the data is indicated by Y and N so in order to do any analysis at all you will need to use these Count functions to establish some numerical data that Excel can use to help analyze the information on the worksheet.

3. Click in cell M4. To insert the COUNTIF function click on the button (see first image below). In the Search for a function box type in COUNTIF and click Go, then OK again. Then in the Function Arguments and the Range box enter E4:L4 and in the Criteria box enter y and click OK. You should see the number of y’s in this row displayed as a number. Use the Fill Handle to copy down this formula through cell M24.

4. In cell E25 use the COUNTIF function to count how many times the letter “Y” appears in cell range E4:E24. Use the Fill Handle to copy this formula through cell L25.

5. In cell B25 use the COUNT function, which should appear automatically when you hit the Function button (see above in the circle). So select the COUNT function. In the Value1 box (which is the cell range) enter C4:C24. Excel will count the number of Office Specialists in the list based on their age being displayed in column C.

6. In cell E26 create a formula that will display the percentage of the specialists that are certified in Word. You will divide cell E25 by B25 BUT hit the F4 key so that the $ signs appear giving you $B$25 (this is called an Absolute Reference). Now click up in your Formula bar where you see your formula =E25/$B$25 and insert the ROUND function just after the = sign like you see in the example here. You will need to add 2 parenthesis after ROUND and 1 parenthesis after $B$25 then a comma and a 2 and a closing parenthesis. Your formula will look like the image above. Use the Fill Handle to copy this formula through to cell L26.

ROUND Function – The ROUND function is used to round a number to a specific number of decimal places. It is different from just using the Decrease or Increase Decimal Place buttons. When you use these buttons the number that is displayed in the cell appears to be rounded up or down based on the rules of rounding. But in reality, this number is just displayed that way, it isn’t actually rounded with the excess decimals being removed completely from the value. The same is true when you use Format, Cells, Number and change the decimal place. ROUND actually reduces the number to the specified number of decimal places. Does it really matter which way you do it? Not if the long range results aren’t important, but if you use the derived value in another formula the extra decimal places may actually impact the long-term mathematical results and throw things off.

7. In cell B27 use the COUNTIF function to count the number of Males in the Gender column. Be sure to use the correct search criteria by examining the Gender column to decide what the criteria will be.

8. In cell B28 use the COUNTIF to display the number of Females in the Gender column.
9. In cell B29 you are going to use the ROUND function with the AVERAGE function. Key in the following for your formula: =ROUND(AVERAGE(C4:C24),1) functions to find the average age of the specialists in the group and to round that number down to just 1 decimal place.

10. In cell B30 use =ROUND(AVERAGE(D4:D24),1) as your formula to find the average experience of the specialists in the group and round the number of years to 1 decimal place.

**Formatting Instruction**

11. Select cells A1:M1 and use the Merge and Center button to center this text across the worksheet.

12. Keep these cells selected and the right click and go to Format Cells.
   b. Then click the Fill tab and select Dark Blue (top row, 4th column) for the cell background. Click OK
   c. Right the row 1 button and select Row Height and change it to 45.

13. Select cells B3:M3 and right click, Format Cells and on the Alignment tab change the text Orientation is at 90° with the Horizontal alignment set as Centered and the Vertical alignment at bottom.

14. Right click the row 3 button and change the Row Height to 60.

15. Select the column buttons B-M and then right click and change the Column Width of 6.

16. Select cells A3:M3 and apply a Double Bottom border. Select cells A24:M24 and apply a Double Bottom border


18. Select cells E26-L26 and make them %.


20. Now AutoFit the content in column A.


22. Save your work.

**Conditional Formatting**

There may be times when you would like your data to be easier to interpret. Creating charts help, but there is another option available to you which will allow you to change the appearance of your data based on some conditional value. This kind of formatting is called Conditional Formatting because the data must meet certain conditions to have a format applied to it. For example, if you created a worksheet to track the activity of your checkbook and wanted to have any balance that drops below a certain level appear in red, you can apply conditional formatting to do this.

In this assignment you want to be able to quickly tell the Y’s from the N’s in your data by formatting a cell differently if it is a Y. When you do this, each time one of the employees qualifies for another qualification and their information is changed, the cell which changes from an N to a Y will be formatted differently.

Follow the steps and use the images below to apply Conditional Formatting to the specific data.
23. Select cells E4:L24 and click Conditional Formatting on the Home tab of the Ribbon. Following the example above and for Highlight Cells Rules go to Text that Contains and click. You want to have the N’s stand out but maybe just the text and not the entire cell, so change the “with” to Red Text and click OK. Now you will see that all the N’s are shown in red. When the N changes to a Y the format automatically changes. Format, and select Conditional Formatting. When this dialog box appears you will make some changes.

**Chart Creation**

24. You are now going to create a bar chart that shows the number of Office Specialist employees who are certified to teach each software program.
   b. Insert a bar chart and select the 1st chart option under 3D.
   c. Select Chart Layout 8.
   d. Move and position the chart so the upper left corner is in cell A32 and resize it so the bottom right corner is in cell M60.
   e. Click on the Series1 legend and delete it.
   f. Make your title: **Certified Office Specialists**
   g. Make the vertical Axis Title: **Programs**
   h. Make the horizontal Axis Title: **Number of Certifications**

**Final Steps**

25. Click on cell A2. Change the Page Setup so the worksheet will Print to 1 Page.
26. Add a Header with your Name in the left section and Date in the right section. Add a Footer and Insert the File Name in the Left section.
27. Save and do a Print Preview to make sure that your worksheet and chart is going to print correctly.
28. Print your worksheet on the color printer and turn it in. Return your assignment material.